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ВСТУП 

Кредитний модуль “Інтелектуальні системи управління” дисципліни 

“Технології штучного інтелекту” дає можливість студентам ознайомитися 

з теорією та практикою створення та використання систем, які 

використовують неформальні знання фахівців, тобто систем штучного 

інтелекту (ШІ). До останніх належать експертні системи, нечіткі системи 

та нейронні мережі. 

Однією з важливих складових систем ШІ є база знань. Її формування 

потребує навичок роботи з нечіткою інформацією, отриманою від 

експертів. 

Метою проведення лабораторних робіт, описаних у цьому 

методичному виданні, є краще засвоєння студентами знань про методи 

формалізації інформації, отриманої від експертів; типи моделей знань та 

даних; загальну структуру та властивості експертних систем; особливості 

роботи з нечіткими множинами; способи розробки нечітких систем 

керування. 

Завдання до лабораторних робіт передбачають проведення 

досліджень в основному з тими технологічними об’єктами, які студент 

розглядав у бакалаврському дипломному проекті чи вибрав, як основний 

при роботі над магістерською дисертацією. Це дозволяє виступати йому й 

ролі справжнього експерта. 

При виконанні лабораторних робіт передбачено використання 

математичних процесорів MathCAD та MATLAB.  
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ЛАБОРАТОРНА РОБОТА № 1 

ВИКОРИСТАННЯ ТА ДОСЛІДЖЕННЯ СИСТЕМ 

ЕКСПЕРТНОГО ОЦІНЮВАННЯ 

Мета роботи – навчитися отримувати, обробляти та аналізувати 

знання експертів при автоматизації технологічних процесів, дослідити 

особливості систем експертного оцінювання. 

 

Основні теоретичні відомості 

 

При автоматизації складних технологічних систем виникають 

наступні задачі: 

- оцінювання тісноти зв’язків між технологічними змінними, як 

вимірюваними, так і не вимірюваними; 

- визначення факторів для включення у математичну модель; 

- визначення пріоритетності встановлення контрольно – 

вимірювальної апаратури; 

- визначення керувальних змінних; 

- визначення причин аварійних ситуацій тощо. 

Ці задачі можуть бути успішно розв'язані лише з урахуванням 

досвіду фахівців. Отже, класифікацію ситуацій й усунення тих з них, які 

можуть призвести до руйнування самої системи, доцільно здійснювати на 

основі систем експертних знань. Алгоритми і програмне забезпечення, які 

дають змогу отримати і обробити таку експертну інформацію, називаються 

системами експертного оцінювання (СЕО). При їх використанні 

експерти надають факторам, які впливають на певну систему, бали (так 

звані ранги).  
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Правила виставляння рангів залежать від вибраного способу 

ранжування. В цій лабораторній роботі будуть досліджуватись два 

алгоритми: одночасного та попарного ранжування. 

На рис. 1.1 наведено загальну для обох способів схему алгоритму 

експертного оцінювання. 

При одночасному ранжуванні експерт отримує для порівняння 

одразу весь перелік факторів і проставляє кожному з них відповідний ранг. 

Алгоритм попарного ранжування базується на тому, що експерт 

порівнює фактори попарно. 

Алгоритм, наведений на рис.1.1, має в цілому лінійну структуру, але 

його використання передбачає декілька циклів. Вони викликані, по-перше, 

опитуванням декількох фахівців а, по-друге, неодноразовим їх 

опитуванням. Опишемо вищенаведений алгоритм спочатку на прикладі 

одночасного ранжування. 

Блок 1. Визначення критеріїв компетентності експертів. При 

виборі експертів керуються предметом експертизи, її метою і вимогами до 

однорідності експертів.  

У прикладі, який наведено у лабораторній роботі, критеріями 

компетентності стали стаж роботи на даному технологічному обладнанні 

та виробничий розряд (кількість критеріїв KR=2). 

Блок 2. Збирання даних про експертів. У цій частині алгоритму до 

ЕОМ заводять дані про кожного експерта відповідно до вибраних критеріїв 

компетентності (кількість експертів NE=10). Приклад до блоку 2 наведено 

у табл. 1.1. 
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Рис.1.1. Схема алгоритму роботи системи експертного оцінювання  
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                 Таблиця 1.1.Дані про компетентність експертів 

Критерій 

компетентності 
Номер експерта 

1 2 3 4 5 6 7 8 9 10 

Стаж роботи 

(років) 
0,5 5 3,5 0,5 1,5 1 0,4 8 3 6 

Розряд 5 6 6 4 5 4 3 5 6 5 

 

Блок 3. Ранжування експертів. У цьому блоці експертам надають 

ранги у відповідності до числових значень критеріїв їхньої компетентності 

(чим більші стаж та розряд, тим менші відповідні ранги). Ранжування 

виконують за кожним з критеріїв окремо. Якщо є однакові ранги, то 

переходять до нормальної матриці ранжування, а потім розраховують суму 

рангів за всіма ранжуваннями.  

Результат такої обробки даних поданий у табл. 1.2. 

 

Таблиця 1.2 Нормальна матриця ранжування експертів  

Номер ранжування 
Номер експерта 

1 2 3 4 5 6 7 8 9 10 pj,u 

1(за стажем) 8,5 3 4 8,5 6 7 10 1 5 2 2 

2 (за розрядом) 5,5 2 2 8,5 5,5 8,5 10 5,5 2 5,5 3+4+2 




KR

j
ijy

1

 14 5 6 17 11,5 15,5 20 6,5 7 7,5 - 

Результуючий ранг 7 1 2 9 6 8 10 3 4 5 - 

 

Блок 4. Оцінка узгодженості ранжування експертів. У табл. 1.2 

величина ujp , - це кількість повторень u-о рангу у j -у рядку; 

 


KR

j
ijy

1

 - сума рангів, отриманих і-м експертом у KR ранжуваннях. 
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Для з'ясування узгодженості ранжування експертів визначають 

коефіцієнт конкордації і оцінюють його статистичну значущість. 

Приклад розрахунку коефіцієнта конкордації ранжування експертів: 

a) розрахунок середнього рангу нормальної матриці рангів експертів: 

;11)1(
2

1
 NEKRB  

б) обчислення суми квадратів різниць між членами сумарного 

ранжування і членами ряду, який складено із середніх значень: 

;256)( 2

11

 


KR

j
ij

NE

i
e ByS  

в) визначення коефіцієнта конкордації ранжування експертів: 

,

)(

12

1

32






L

j
j

e
e

PKRNENEKR

S
W     (1.1) 

де L  - кількість рядків у табл. 1.2, які містять однакові («зв'язані») ранги, 

L=2. 

Величину jP  розраховують за формулою 





U

u
ujujj ppP

1
,

3
, ),(  

де U - кількість типів «зв’язаних» рангів у j  - му рядку табл. 1.2 (для 1j , 

U=1; для ,2j  U=3). 

Статистичну значущість коефіцієнта конкордації перевіряють за 2 -

критерієм (критерієм Пірсона). Розрахункове значення визначають за 

виразом 

.76,14)1(2  ee WNEKR  

При рівні значущості 1,0a  і ступені вільності 91 NENU , 

табличне значення 2
,table   критерію дорівнює 14.7.  
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Отже, виконується умова 

2
abl ,

2
 tee  .     (1.2) 

Таким чином, можна вважати узгодженим ранжування експертів при 

1,0 . 

Блок 5. Розрахунок «ваги» думок експертів. Найдосвідченішим 

експертом вважається той, у якого сума рангів буде найменшою (у 

розглянутому прикладі це другий експерт). Його думці надається «вага» 

22  . Думка найменш досвідченого експерта (7-го) має «вагу» 17  . 

Для визначення «ваги» думок інших експертів використовують рівняння 





KR

j
iji yca

1

. 

Для визначення коефіцієнтів a та b запишемо систему 









,201

;52

ca

ca
 

звідки ,3/7a 15/1b . 

Для прикладу визначимо «вагу» думки 1-о експерта: 

4,114
15

1

3

7
3  . 

Блок 6. Складання переліку факторів ранжування. У список для 

ранжування включають фактори, які впливають на хід технологічного 

процесу. 

Блок 7. Ранжування факторів. У цій частині алгоритму виконують 

власне ранжування як таке. Згідно з методом одночасного ранжування. 

експерти ставлять у відповідність кожному фактору ранг - число з 

натурального ряду K,1  , де K - кількість факторів у списку. Правило 

ранжування таке - чим менше фактор впливає на технологію, тим більший 

ранг йому треба надати.  
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Значущість кількох факторів може бути однаковою, і їм надають 

однакові ранги. Приклад ранжування наведений у табл. 1.3. 

                  Таблиця 1.3 Результати ранжування факторів 

Номер експерта 

),1( NEj   

Номер фактору ),1( Ki   

1 2 3 4 5 6 

1 2 2 2 2 1 1 

2 3 3 3 2 1 1 

3 2 4 2 3 1 1 

... - - - - - - 

 

У цьому ж блоці виконується перехід до нормального виду матриці 

рангів (див.табл. 1.4), тобто враховують той факт, що декілька факторів 

набули одного і того ж рангу. 

                           Таблиця 1.4 Нормальна матриця рангів 

Номер експерта 

),1( NEj   
Номер фактору ),1( Ki   

 1 2 3 4 5 6 

1 4,5 4,5 4,5 4,5 1,5 1,5 

2 5 5 5 3 1,5 1,5 

3 3,5 6 3,5 5 1,5 1,5 

... - - - - - - 

 

Блок 8. Корекція результатів ранжування факторів. Елементи 

нормальної матриці коригують з урахуванням «ваги» думок фахівців, які 

розраховують у блоці 3. 
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 Основними показниками сили впливу фактору на процес є 

«зважені» суми рангів: 

,
1





NE

j
jija  

де ija  - ранг, що був наданий i -у фактору j -м експертом без урахування 

його компетентності. 

Результати експертного опитування, в яких врахована «вага» думок 

експертів, наведені у табл. 1.5. 

Таблиця 1.5 Таблиця «зважених» рангів 

Номер 

експерта 

),1( NEj   

Номер фактора ),1( Ki     

 

t  1 2 3 4 5 6 

1 6,30 6,30 6,30 6,30 2,10 2,10 4; 2 

2 10,00 10,00 10,00 6,00 3,00 3,00 3; 2 

3 6,76 11,56 6,76 9,65 2,90 2,90 2; 2 

... - - - - - -  





NE

j
jija

1

 52,72 69,37 69,87 65,88 36,89 41,63 
 

 

У табл. 1.5 параметр ,jt  - кількість однакових рангів різних типів у 

рядку. Так, у першому рядку два різних типи: 6,30 та 2,10. Перших значень 

- 4, інших - 2; тому 1,1t =4; 2,1t =2. Якщо немає однакових значень у рядку, 

то t =0.  

Блок 9. Визначення сумарного ранжування факторів. Виконують 

підсумовування «зважених» рангів по всіх експертах (див. 



NE

j
jija

1

 табл. 

1.5). 
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Блок 10. Вибір найбільш суттєвого фактора. Умова вибору - 

найменше значення суми рангів (у прикладі це 5-й фактор). 

Блок. 11. Оцінка узгодженості ранжування факторів. Обчислюють 

коефіцієнт конкордації за формулою, аналогічною (1.1): 

,
1

)(

12

1

2

1

32


































NE

j
j

NE

j
j

f
f

NE
TKKNE

S
W  

де 







 



























K

i

K

i

NE

j
jij

NE

j
jijf

K

a

aS
1

1 1

1

36,1045 ; 




 
P

jjj ttT
1

3 ),(  

 

P  - кількість типів «зв'язаних» рангів в j -у рядку.  

Після цього розраховують значення критерію Пірсона за формулою 

9,11)1(2  ff WKNE . 

Табличне значення критерію Пірсона визначають за рівнем 

значущості   і ступенем вільності 51 KNF . Так, для  =0,05 і NF=5 

отримаємо 2
,tablf =11,1.  У цьому разі виконується умова 

2
,

2
tablff  ,                                          (1.3) 

і можна говорити про наявність узгодженості у думках експертів при 

ранжуванні факторів. 
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Блок 12. Планування подальших дій. Якщо умова (1.3) виконується, 

то задачу можна вважати розв’язаною. У тому випадку, коли умова (1.3) не 

виконується, то потрібно звернути увагу на правильність формулювання 

задачі дослідження, уточнити склад групи експертів і повернутися до 

початку розв'язання задачі (від блоку 1). 

Розглянемо застосування алгоритму для метода попарного 

ранжування. Відмінності є для блоків 7-11, далі позначатимемо ці блоки 

індексом «п». 

Блок 7
п
. Експерт згідно з цим методом оцінює більш значущий 

фактор одиницею (1), а інший нулем (0). Результат такого ранжування 

може бути подано таким, наприклад, як у табл. 1.6. 

Таблиця 1.6. Результати ранжування при парному порівнянні 

Номери факторів 1 2 3 ... К 

1 - 1 0 - - 

2 0 - 1 - - 

3 1 0 - - - 

... - - - - - 

К - - - - - 

 

Одиницю записуємо у комірку ij ( i  - номер рядка, j  - номер 

стовпчика), якщо фактору і віддаємо перевагу перед фактором j . Таку 

таблицю заповнює кожний з NЕ експертів.  

Блок 8
п
. Якщо треба врахувати компетентність експерта, то кожний 

елемент таблиці перемножують на «вагу» думки відповідного експерта. 

Блок 9
п
. Для визначення результату ранжування створюють нову 

таблицю, у кожній її комірці вказують суму чисел, які знаходяться у 

відповідних комірках всіх NE таблиць.  
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Блок 10
п
. Підраховують суму чисел у всіх комірках для кожного 

рядка ),1( Kii  . Чим більша ця сума, тим більше значення має i -й фактор.  

Блок 11
п
. Для визначення узгодженості ранжування використовують 

лише частину таблиці, розташовану або над головною діагоналлю, або під 

нею.  

Коефіцієнт конкордації обчислюють за формулою 

)1()1(

4
4 1 1

2

max

0







KKNENE

C

Q

Q
W

K

ji

r

, 

де 0
2

r
C  - біноміальний коефіцієнт; ijr  - число, що розміщено у комірці з 

координатами )( jiij  . 

Значення Q може бути отримане таким чином: 









K

j
i

KNE
ij

K

j
i

ij CCrNErQ

1
1

22

1
1

2 . 

Для оцінювання значущості коефіцієнта узгодженості W  

використовують критерій 2 . 

Розраховують значення цього критерію так: 


















2

3

2

1

2

4
22

2

NE

NE
CCQ

NE

NEK
f , 

Далі порівнюють 2
f  з табличним значенням 2

,tablf  для рівня 

значущості   і  NF  ступенів вільності.  
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Параметр NF обчислюють за формулою 

2

2

)1(

)1(






NE

NENEC
NF

K

 

і округлюють до найближчого цілого. 

 

Порядок виконання роботи 

 

1. Сформулювати задачу дослідження. Визначити список факторів, 

які треба проранжувати за ступенем впливу на певний критерій. 

2. Провести експертні опитування з врахуванням компетентності 

експертів та без нього. Роботу з програмами виконувати за зразками, 

наведеними в лабораторній роботі (див. рис.1.2 - 1.8 для одночасного 

ранжування та рис.1.9 – 1.11 для попарного). 

3. Розрахувати показники експертизи за обома способами 

ранжування. Визначити узгодженість ранжувань факторів та експертів за 

заданими критеріями компетентності. 

Розрахунки виконати у середовищі MS Excel. 

 

Вміст звіту 

 

Опис предметної області, задача дослідження, початкові та 

нормальні матриці ранжування факторів та експертів, результати 

ранжування у числовому та графічному видах. Розрахунки, виконані у MS 

Excel.  

За результатами лабораторної роботи дослідити суперечливість 

думок експертів. Зробити висновки з наступних питань:  

а) про можливість роз’язання поставленої задачі аналітичним чи 
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експериментально-статистичним методами; 

б) про узгодженість думок експертів; 

в) про узгодженість вибраних критеріїв компетентності; 

г) про вплив критеріїв компетентності експертів на результати 

ранжування факторів; 

д) про наявність суперечностей між результатами двох методів 

ранжування. 

Контрольні запитання 

 

1. Для чого використовують системи експертного оцінювання? 

2. Які є СЕО? Як виконується ранжування в кожній з них? 

3. Як визначити узгодженість думок експертів у кожній із систем? 

4. Як визначити «вагу» думки експерта? 

5. Як використати дані про компетентність експертів? 

5. Які можуть бути подальші дії при неузгодженості роботи 

експертів? 

6. Як подати результати експертизи графічно?  

7. Опишіть існуючі типи графічних зображень 
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Робочі вікна програми для експертного оцінювання 

 

Рис. 1.2. Формування списку критеріїв компетентності експертів 

 

Рис. 1.3. Формування списку експертів 

 

Рис.1.4. Формування списку факторів 
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Рис.1.5.Уведення даних про компетентність експертів 

 

 

Рис.1.6. Ранжування факторів за методом одночасного ранжування  
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Рис.1.7. Матриці ранжування 

 

 

Рис.1.8. Результати одночасного ранжування 
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Рис.1.9. Попарне ранжування факторів 

 

Рис.1.10. Матриця попарного ранжування 

 

Рис.1.11. Результати попарного ранжування 
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ЛАБОРАТОРНА РОБОТА №2 

ДОСЛІДЖЕННЯ ЕКСПЕРТНОЇ СИСТЕМИ ДЛЯ АНАЛІЗУ 

ПОРУШЕНЬ ПРОЦЕСУ ВИПАЛЮВАННЯ ЦЕГЛИ 

Мета роботи – дослідити структуру бази знань та спосіб роботи 

механізму виведення експертної системи (ЕС) прогнозувального та 

діагностувального типів для предметної області «Керування процесом 

випалювання керамічної цегли». 

Основні теоретичні відомості та рекомендації по використанню ЕС 

Задача запобігання порушенням нормального перебігу 

технологічних процесів виникає при розробці будь-якої системи 

керування. Особливо актуальне розв’язання цієї задачі для виробництв, 

яким притаманні такі риси, як велика потужність, енергоємність, наявність 

вибухо - та пожежонебезпечних речовин. Таким, зокрема, є виробництво 

керамічної цегли. Найбільш важливим його етапом є випалювання цегли в 

тунельній печі. 

Структурно-параметрична схема цього процесу представлена на 

рис.2.1. 

Тунельна піч є складним багатофакторним об’єктом керування із 

значною кількістю матеріальних потоків, властивості якого розподілені за 

всіма координатами, але найбільш суттєво  по довжині. Керування 

окремими процесами, які мають місце у печі (нагрівання, випалювання, 

охолодження матеріалу, згоряння палива тощо), складно здійснювати  
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через відсутність інформації про стан виробів впродовж усього часу, що 

цеглини знаходяться в середині корпусу печі, а це більше двох діб. Через 

ці причини кожне порушення, яке може статися в печі, призводить до 

тривалого пошуку і усунення недоліків і суттєвих матеріальних збитків.  

 

 

Рис.2.1. Структурно - параметрична схема процесу випалювання керамічної 

цегли 

 

Запропонована для дослідження в лабораторній роботі експертна 

система розрахована на функціонування в структурі загальної системи 

керування і виконання наступних задач: 

 діагностування причин аварійних ситуацій; 

 прогнозування можливих порушень нормального режиму роботи. 

Головною складовою ЕС є база знань (БЗ). Інформація, яку 

закладено у БЗ, є переліком фактів та правил використання цих фактів 

(правил продукції). У розглянутій БЗ фактами є можливі порушення 

процесу випалювання, викликані різноманітними причинами.  
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Для кращого сприйняття цієї інформації створено мережу порушень, 

фрагмент якої зображено на рис.2.2. 

Пересування по мережі згори в низ дозволяє виконувати пошук 

причин порушень технологічного процесу, тобто діагностування 

порушень. 

Пересування у протилежному напрямку  знизу на гору, дає 

можливість з’ясувати наслідки кожного порушення, тобто виконує 

прогнозування. 

 

Рис.2.2. Семантична мережа для подання знань про процес випалювання  

  

У вузлах мережі знаходяться факти  можливі порушення. Дуги 

мережі мають смисл «може бути викликане» для діагностування причин 

порушень та «викликає» – при прогнозуванні.  
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Біля кожної дуги мережі розташована певна інформація. При назвах 

контрольованих змінних у квадратних дужках наведено їх менші та більші 

значення. Якщо значення контрольованої змінної набуває значення з цього 

інтервалу, то ситуація, зазначена у верхньому вузлі може викликати 

ситуацію з нижнього вузла. Відсотки означають імовірність виникнення 

порушень: вказані без дужок належать режиму діагностування, з дужками 

– прогнозуванню.  

Приклад трактування мережі для діагностування причин 

порушення Брак продукції. 

Брак продукції з імовірністю 100% має місце тоді, коли визнано 

факт Недопалення цегли. А цей факт з імовірністю 100% може бути 

викликаний порушенням Вихід водопоглинання за допустимі межі. Слід 

зазначити, що Недопалення цегли викликають ще й інші порушення, які 

будуть досліджуватися в ході виконання лабораторної роботи. Для 

прикладу розглядаємо тільки мережу, зображену на рис. 2.2. 

Вихід водопоглинання за допустимі межі може бути викликаний 

наступними подіями: 

 Порушенням ритму проштовхування пічних вагонів з 

імовірністю 3%; 

 Порушенням геометричної конструкції садки з імовірністю 

80%. Ця подія, в свою чергу може бути викликана наступним: 

 Порушенням геометрії футеровки пічного вагона 

(75%); 

 Порушення в роботі автомата - садчика (100%); 

 Порушення в роботі автоматики штовхача пічних 

вагонів (10%).  

 Недотримання максимальної (max) температури 

випалювання з імовірністю 100%. 
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Приклад трактування графу для прогнозування. Почнемо з 

нижніх вузлів мережі. Порушення геометрії футеровки пічного вагона з 

85% імовірністю викликає Порушення геометричної конструкції садки. 

Ця подія, в свою чергу, вплине на Вихід значення водопоглинання за 

допустимі межі з імовірністю 65%, а це з імовірністю 100% є причиною 

Недопалення цегли. 

Для взаємодії ЕС та користувача розроблений механізм виведення. 

Він складається з низки вікон, зокрема Привітання (заставка) (рис.2.3), 

Вибір режиму (рис.2.4), Перелік аварійних ситуацій найвищого 

рівня(рис.2.5), типових вікон діагностування (рис.2.6) та прогнозування 

(рис.2.7) нижніх рівнів. 

Наведемо приклади цих вікон. 

 

Рис.2.3. Заставка ЕС ExpertSys версії 5.1.2 
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Рис.2.4. Вікно з поясненням призначення ЕС ExpertSys та переліком режимів її 

робот 

 

При діагностуванні причин аварії серед наданого переліку можливих 

причин (див. рис. 2.5) треба вибрати ту, яка дійсно відбулася, і могла 

спровокувати появу порушення вищого рівня. На практиці, якщо невідомо, 

яка саме відбулася подія з наданого списку, можна керуватися наведеними 

ймовірностями (див. рис. 2.6). 

 

 

Рис.2.5. Вікно діагностування з переліком аварійних ситуацій найвищого рівня  
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Рис.2.6. Вікно діагностування з переліком аварійних ситуацій першого рівня 

Режим прогнозування дозволяє визначити, до яких наслідків може 

призвести певне порушення. Для того, щоб пришвидшити пошук 

порушення, що сталося,  серед значної кількості їх у БЗ, усі порушення 

умовно розділено на чотири групи (див. рис. 2.7): 

- Контрольовані технологічні змінні; 

- Технологічне обладнання; 

- Система контролю чи керування; 

- Людський фактор. 

 

Рис.2.7. Вікно прогнозування для вибору порушень  
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Усі події, які входять до мережі аварійних ситуацій є сумісними. 

Тому для визначення ймовірності події верхнього рівня, потрібно 

використовувати формулу імовірності для суми N сумісних подій 

нижнього рівня: 

  )(...)()(...)()()...( 1212121 NNnN AAPAAPAPAPAPAAAP

),...()1(...)(...)( 2112321 N
N

NNN AAAPAAAPAAAP    

де Р(А1), Р(А2),...,Р(АN) – імовірності виникнення подій А1, А2, …,АN;  

P(A1A2) – імовірність сумісного виникнення двох подій А1 та А2; 

P(A1A2…AN) – імовірність сумісного виникнення N подій . 

Порядок виконання роботи 

1. Активізувати роботи ЕС за допомогою програми ExpSys_pr з 

папки D:\LD\Koslow_Sakr. 

2. У вікні Привітання (рис.2.3) натиснути кнопку Далі>>>. 

3. У вікні Вибору режиму (рис.2.4) вибрати опцію Діагностування. 

Натиснути кнопку Далі>>>. 

4. З переліку аварійних та передаварійних ситуацій (рис.2.5) вибрати 

Брак готової продукції. Натиснути кнопку Далі>>>. 

5. З переліку ситуацій, що визначають брак продукції вибрати 

Недопалення цегли.  Знайти всі можливі причини появи цього 

порушення. Дані для уведення в програму, наведені у таблиці. 

6. Повернутися до вікна (рис.2.5). Вибрати Брак готової продукції. 

З переліку ситуацій, що визначають брак продукції вибрати Підвар або 

місцеве оплавлення.  Знайти всі можливі причини появи цього 

порушення. 

7. Повернутись до Вікна вибору режиму (рис. 2.4) шляхом 

натискання кнопки <<<Назад. 
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8. Вибрати опцію Прогнозування. Натиснути кнопку Далі>>. 

9. У вікні прогнозування (рис.2.7) розкрити меню, що випадає, а у 

ньому пункт Контрольовані технологічні змінні. Знайти наслідки 

ситуацій: 

 підсоси повітря в каналі печі; 

 порушення аеродинамічного режиму; 

 недотримання максимальної температури випалювання. 

10. У меню, що випадає, вибрати пункт Система контролю чи 

керування. Знайти наслідки ситуацій: 

 погана робота автоматики пічного штовхача; 

 незадовільна робота контуру співвідношення газ/повітря; 

 незадовільна робота контуру керування температурою. 

10. У меню, що випадає, вибрати пункт Людський фактор. Знайти 

можливі наслідки помилкових дій персоналу. 
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Таблиця 

Інтервали значень змінних, які необхідно вводити в програму для 

аварійної ситуації «недопал цегли» 

 

№ 

п/п 
Назва 

Інтервали 
значень 

для 
уведення 

1 Водопоглинання (для браку продукції) 0-30 

2 Максимальна температура випалювання 900-1080 

3 Ритм проштовхування 0,52-0,8 

4 Відхилення значення тиску у трубопроводі з природним газом 0-0,29 

5 Порушення співвідношення витрат гаряче повітря/природний газ 0-20 

6 Перепад тиску між пічним і підвагонеточним каналами 0,25-0,4 

7 Об’єм повітря, що відбирається на сушарку 751-850 

8 Об’єм димових газів, що викидаються 186-350 

9 Температура на початкових позиціях зони випалювання 700-750 

10 Об’єм повітря на кінцеве охолодження 700-799 

11 Залишкова відносна вологість 3,1-4,99 

12 Температура повітря на сушарку 60-79 

13 Час перебування цегли у сушарці 85-90 

14 Температура рециркуляції повітря 50-99 

15 Витрата повітря на швидке охолодження 500-599 

16 Температура повітря, що відбирається на сушарку 150-199 

17 Температура повітря, що подається на колектор 5-14 

18 Температура виробів при надходженні до печі 0-10 

19 Температура фазових перетворень 600-699 
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Контрольні запитання 

1. Що таке експертна система? 

2. Які функції виконує досліджена ЕС? 

3. Назвіть загальні складові ЕС?  

4. Які функції виконує інженер знань при створенні цієї ЕС? 

5. Наведіть приклад спілкування інженера знань з експертом 

предметної області для отримання БЗ цієї ЕС. 

6. На прикладі цієї системи поясніть роботу механізму 

виведення. 

7. Як розрахувати ймовірність заданої викладачем події 

верхнього рівня за ймовірностями подій нижнього рівня? 

Вміст звіту 

Зображення мереж аварійних ситуацій Брак готової продукції та 

Погіршення якості готової продукції. Приклад розрахунку 

ймовірності порушення верхнього рівня за результатами порушень 

нижнього рівня. 

Фреймова структура, яку можна використати для бази знань 

досліджуваної експертної системи. 
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ЛАБОРАТОРНА РОБОТА №3 

РОБОТА З ОБОЛОНКОЮ ЕКСПЕРТНОЇ СИСТЕМИ 

ПРОГНОЗУВАЛЬНОГО ТА ДІАГНОСТУВАЛЬНОГО ТИПІВ 

Мета роботи – отримати поняття про оболонки експертних систем, 

дослідити процес формування бази знань ЕС прогнозуючого та 

діагностуючого типів для предметної області «Автоматизація 

технологічних процесів». 

Основні теоретичні відомості та рекомендації по використанню 

оболонки 

Отримані від експертів знання про предметну область, оформлені 

певним чином, називають базою знань (БЗ). 

Способи розв'язування задачі та організації діалогу з користувачем 

(наприклад, у якій формі роздрукувати результат рішення, вивести текст 

повідомлення, організувати ілюстрації і т. ін.) називають механізмом 

виведення. Механізм виведення, який не містить знань, називають 

оболонкою ЕС. Отже, оболонка ЕС є системою програм, за допомогою 

якої можна в подальшому створювати експертні системи для різних 

предметних областей. Існує значна кількість оболонок, які відрізняються за 

характеристиками предметної області, призначенням ЕС, за способом 

спілкування з користувачем, реалізацією внутрішньої структури бази знань 

тощо. 

У даній лабораторній роботі розглянута одна з оболонок, 

використовуючи яку студент зрозуміє проблеми спілкування з 

оболонками, усвідомить необхідність структурованості знань предметної 

області, навчиться використовувати моделі знань.  
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Запропонована оболонка призначена для роботи зі знаннями, 

моделлю яких є ієрархічна мережа. Діагностика і прогноз найчастіше 

можуть бути представлені ланцюжками міркувань, які відповідають такій 

моделі.  

У лабораторній роботі досліджують оболонку YarExpert, яка має 

характерний для Windows - програм рядок заголовка і рядок меню. Це 

меню включає наступні команди: База знань, Режими роботи, 

Параметри, Довідка. 

Команда База знань призначена для дій з файлами БЗ і має опції, 

представлені на рис. 3.1.  

 

 

Рис. 3.1. Опції команди База знань 

 

При створенні файлу БЗ використовують команду Створити нову 

базу знань. У результаті її виконання виникає діалогове вікно Зберегти 

файл бази знань, у якому треба вказати місце майбутнього розташування 

файлу з БЗ на диску, і натискувати кнопку Створити.  

Робота з файлом БЗ можлива, якщо виконати команди меню База 

знань / Відкрити базу знань. При цьому виникає діалогове вікно 

Відкрити файл бази знань. У цьому вікні слід вказати шлях для пошуку 

необхідного файлу, його ім'я і натиснути кнопку Відкрити.  
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Якщо відкрили нову, порожню БЗ, то з'являється вікно з 

повідомленням про те, що її можна тільки заповнювати, а інші операції з 

нею неможливі. 

Команда головного меню Режими роботи має опції, представлені 

на рис.3.2: 

 

Рис. 3.2. Опції команди Режими роботи 

 

Для заповнення і редагування записів БЗ потрібно виконати команди 

Режими роботи / Редагування бази знань. При формуванні БЗ необхідно 

ввести пароль в спеціальне віконце. Після правильної відповіді виникає 

робоче вікно для заповнення і редагування БЗ. Воно має свій рядок меню з 

командами Створення ситуацій найвищого рівня, Редагування 

ситуацій, Видалення ситуацій найвищого рівня. 

Перша з вказаних команд має текстове поле Введіть нову ситуацію. 

В нього треба внести один з вузлів найвищого рівня мережі (графу) 

ситуацій БЗ вибраної предметної області. Так, для мережі ситуацій, 

показаної на рис. 3.3, на найвищому рівні розташовані вузли Брак 

продукції і Перевищення гранично - припустимих концентрацій (ГПК) 

СО (окису вуглецю). У текстове поле слід увести один з цих записів і 

натискувати кнопку Створити.  
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Якщо всі ситуації найвищого рівня введені в БЗ, то можна перейти 

до команди Редагування ситуацій. Вона призначена для заповнення 

наступних рівнів мережі ситуацій. 

              

Брак 

продукції 

Перевищення 

ГПК СО 

Погана 

сировина 

Відсутність 

своєчасних 

результатів  

аналізів 

Температура 

в апараті 

вища за 

норму 

Погано 

працюють 

попередні 

етапи технології 

 

Рис. 3.3. Приклад мережі ситуацій 

У результаті виконання цієї команди з'являються дві зони (див. 

рис.3.4): знизу  список, що розкривається (як завжди, із позначкою „V”), а 

під нею – велика зона зображення мережі (спочатку вона порожня). Після 

розкриття списку клацніть лівою кнопкою миші (ЛКМ) по вибраній 

ситуації найвищого рівня, і вона залишиться видимою в полі списку (у 

даному прикладі це Брак продукції). 

 

 

Рис.3.4. Вид вікна команди Режими роботи 
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Для створення підлеглих їй ситуацій клацніть правою кнопкою миші 

(ПКМ) по зоні зображення мережі, з'явиться меню з двома активними 

опціями: Додати ситуацію 1-о рівня (тобто вузол) і Додати ситуацію 

рівнем нижче (для 2-о рівня і нижче). На рис.3.5 показано це меню в зоні 

зображення мережі. 

 

Рис. 3.5. Вікно для створення ситуацій 1о і подальших рівнів 

 

Вибір першої опції призводить до появи діалогового вікна 

Редагування ситуацій з трьома текстовими полями (див. рис. 3.6):  

- Ситуація (у ньому потрібно дати назву вузла мережі); 

- Рекомендовані дії (якщо вузол завершує ланцюжок ситуацій, то 

потрібно вказати, які дії слід зробити для усунення аварії; для проміжних 

вузлів це поле не заповнюється); 

- Імовірність для ситуації, % (слід вказати, з якою ймовірністю 

ситуація вищого рівня може викликати підпорядковану). 

У результаті заповнення цих полів формуються всі вузли і зв'язки 

мережі ситуацій за винятком найвищого. 
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Рис. 3.6. Вікно створення і редагування ситуацій 1-о рівня 

 

Меню зони зображення мережі з появою 1 – о і подальших рівнів 

розширюється – активними стають не дві опції, а всі чотири разом (див. 

рис. 3.7).  

 

Рис. 3.7. Вікно створення і редагування ситуацій 2-о та нижчих рівнів 
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Якщо вузол мережі містить у собі вузли нижчого рівня, то в зоні 

зображення мережі він має позначку „+” по аналогії з тим, як в 

Провіднику (Windows Explorer) відзначають каталог, що має підкаталоги 

(див. рис. 3.8). 

 

Рис. 3.8. Відображення фрагмента мережі з вузлами найвищого і 1-о рівнів 

 

Якщо в результаті роботи з програмою були видалені певні записи, 

то перед її закриттям слід виконати команди меню База 

знань / Оптимізувати БД бази знань. Це приведе до дійсного видалення 

записів, а не тільки до втрати їх видимості на екрані. 

Режим діагностування, який дозволяє визначити основну причину 

аварійної ситуації, що створилася, активізується командами Режим 

роботи / Діагностування (див. рис.3.2). У результаті виникає вікно, 

розділене на дві зони (рис.3.9). Спочатку обидві зони однакові. Надалі в 

лівій зоні відбиватиметься рух по мережі ситуацій, тобто поступово 

з’являтимуться всі вузли, задіяні в процесі роботи.  

Права зона під назвою Можливі причини аварії є робочою. У ній 

треба за допомогою ЛКМ відзначати існуючу ситуацію і натискувати 

кнопку Вперед. Такі дії призводять до появи у правій зоні переліку 

підлеглих ситуацій, тобто ситуацій, що розташовані нижче по мережі. З 

ними поводяться схожим чином. 



39 

 

Рис. 3.9 Початок роботи в режимі Діагностування 

Робота продовжується доти, доки не буде досягнуто кінцевого вузла 

на дузі мережі. Ознакою цього є поява спеціального вікна з назвою 

YarExpert. У ньому міститься наступна інформація (див. рис. 3.10): 

- можлива причина аварії; 

- ланцюжок міркувань, що привів до зробленого висновку; 

- рекомендації по усуненню аварії; 

- імовірність, з якою ситуація найвищого рівня пов'язана зі 

знайденою причиною аварії. 

 

Рис.3.10. Вид вікна ЕС з результатом процесу діагностування 
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Процес прогнозування починається після виконання команд 

Режими роботи / Прогнозування (див. рис.3.2). У правій частині вікна з 

назвою Ситуації користувач бачить вузли всіх рівнів мережі окрім 

найвищого і може вибрати за допомогою ЛКМ необхідний. Активізація 

вузла призводить до того, що в лівій частині вікна розкривається дуга 

мережі, пов'язана з позначеною ситуацією (див. рис.3.11). Таким чином, 

користувач може побачити, до яких наслідків призведе вказана ним подія. 

 

 

Рис.3.11.  Вид вікна при прогнозуванні ситуацій 

 

Команда головного меню Параметри дає можливість працювати із 

заставкою, змінювати пароль і переходити на іншу мову (див. рис.3.12). 
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Рис.3.12. Вид вікна команди Параметри 

 

Порядок виконання роботи 

 

1.  Погодити з викладачем предметну область (технологічну систему) 

і зміст завдання, для якого буде використано оболонку ЕС. 

2.  Дослідити особливості предметної області, скласти мережу 

аварійних ситуацій у відповідності до завдання. Мережа повинна містити 

не менше 3 – х вузлів вищого рівня. 

3.  Заповнити базу знань ЕС. Перевірити чи відповідає структура 

ситуацій у файлі структурі розробленої мережі.  

4.  Виконати процес діагностування аварійних ситуацій. Перевірити 

правильність роботи ЕС по мережі. 

5.  Виконати процес прогнозування аварійних ситуацій. Перевірити 

правильність роботи ЕС по мережі. 
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Вміст звіту 

 

Опис предметної області, задача дослідження, мережа аварійних 

ситуацій і рекомендацій по їх усуненню, результати дослідження 

взаємозв’язків між аварійними ситуаціями.  

Контрольні запитання 

1. Що таке оболонка ЕС? 

2. Наведіть класифікацію оболонок. 

3. Поясніть методику створення ЕС прогнозуючого та діагностуючого 

типів для системи керування технологічними процесами. 

4. Визначте місце ЕС, розробленої в ході виконання лабораторної 

роботи, в системі керування технологічними процесами. 
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ЛАБОРАТОРНА РОБОТА №4 

СТВОРЕННЯ НЕЧІТКОЇ МОДЕЛІ ТЕХНОЛОГІЧНОГО ОБ'ЄКТА 

ЗАСОБАМИ ПАКЕТУ MATLAB 

Мета роботи  ознайомитись із способом створенням математичних 

моделей об’єкта управління на базі нечіткої логіки засобами MATLAB, 

навчитися досліджувати такі моделі. 

Основні теоретичні відомості 

Нечітка логіка (Fuzzy Logic) – це надмножина класичної булевої 

логіки. Вона розширює можливості останньої, дозволяючи застосовувати 

концепцію невизначеності в логічних висновках. Апарат нечіткої логіки 

теж строгий і точний, як і класичний, але разом із протилежними 

значеннями «хибність» та «істина» він дозволяє використовувати 

значення, що знаходяться між ними.  

Нечітка множина (Fuzzy Set) є сукупністю елементів довільної 

природи, щодо яких не можна з повною визначеністю стверджувати, чи 

належить той або інший елемент сукупності певній множині чи ні. Іншими 

словами, не можна чітко визначити, що даний вислів є «хибністю» або 

«істиною» («чорним» або «білим»), оскільки множина «чорно-біле» 

містить усі відтінки від чорного до білого.  

Функція належності (Membership Functions) є апаратом для 

символьного (математичного) опису нечіткої множини. Вона показує цей 

перехід від «істини» до «хибності». Жодних обмежень на вибір конкретної 

функції належності немає.  
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Проте, на практиці зручно використовувати ті з них, які допускають 

аналітичне подання у вигляді простої математичної функції. Приклади 

простих математичних функцій наведені нижче. Необхідність типізації 

окремих функцій належності обумовлена реалізацією відповідних функцій 

в інструментальних засобах, наприклад, у MATLAB. 

До першого типу функцій належності віднесено ті, які складаються з 

відрізків прямих ліній. Найхарактернішими прикладами таких функцій є 

«трикутна» (рис. 4.1.а) і «трапецевидна» (рис. 4.1.б) функції. У нашому 

випадку кожна з цих функцій задана на універсумі Х=[0, 10]. 

 

 

а                                                            б 

Рис. 4.1 - Графіки функцій належності трикутної (а) і трапецевидної (б) форми 

Ці функції використовують для задання таких властивостей множин, 

які характеризують невизначеність типу: «приблизно дорівнює», «середнє 

значення», «розташований в інтервалі», «подібний об'єкту», «схожий на 

предмет» і т. ін.  

Z-подібні (рис.4.2 а) і S-подібні (рис.4.2.б) функції належності також 

отримали свою назву по вигляду кривих, які представляють графіки. 

Перша з функцій цієї групи називається Z-подібною кривою або сплайн -

 функцією. 
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б 

 

а 

Рис. 4.2. Графіки Z-подібної (а) та S-подібної (б) функції належності для значень 

параметрів а = 3, б = 6 

 

Ці функції використовують для подання таких властивостей нечітких 

множин, які характеризуються невизначеністю типу: «мала кількість», 

«невелике значення», «незначна величина», «низька собівартість 

продукції», «низький рівень цін або доходів», «низька процентна ставка» і 

багатьох інших. Загальним для всіх таких ситуацій є слабий ступінь прояву 

тієї або іншої якісної або кількісної ознаки.  
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До типу S- подібних і одночасно Z-подібних функцій належності 

може бути віднесено так звану сигмовидна функцію (сигмоїд), яку в 

загальному випадку задають аналітично наступним виразом: 

,
1

1
),;(

)(3 bxaS
e

baxf


  

де а, b  параметри, що приймають довільні дійсні значення і впорядковані 

відношенням: a<b, а e  основа натурального логарифму.  

При а > 0 отримують S - подібну функцію, а при a < 0  Z - подібну 

функція належності. 

Приклади графіків цієї функції для деякої нечіткої множини А і 

універсуму Х=[0, 10] зображено на рис. 4.3. При цьому S - подібні функції 

належності відповідають значенням параметрів a = 3, b = 6 (рис. 4.3.а), а Z-

подібні функції належності відповідають значенням параметрів а=-3, b=6 

(рис. 4.3.б). 

Розглянуті S - подібні функції використовують для подання таких 

нечітких множин, які характеризуються невизначеністю типу: «велика 

кількість», «велике значення», «значна величина», «високий рівень доходів і 

цін», «висока норма прибутку», «висока якість послуг», «високий сервіс 

обслуговування» і багатьох інших. Загальним для всіх таких ситуацій є 

високий ступінь прояву тієї або іншої якісної або кількісної ознаки.  



47 

 

 

 

а 

 

б 

Рис. 4.3 - Графіки сигмоідальної функції належності для значень 

параметрів а = 3, b = 6 (а)  та  а = -3, b = 6 (б) 

 

Як окремі випадки Z- і S-подібних кривих зручно розглядати так 

звану лінійну Z - подібну функцію (рис. 4 а) і лінійну S - подібну функцію 

(рис. 4 б). 
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             а 

 

  б 

Рис.4.4. Графіки лінійної Z - подібної функції (а) і лінійної S - подібної функції (б) 

належності для значень параметрів а = 3, b = 6 

 

Ці лінійні Z - і S - подібні функції використовують для побудови 

розглянутих вище трикутної і трапецевидної функцій належності (див. 

рис.4.1).  

Система MATLAB (скорочення від англ. MATrix LABoratory  

матрична лабораторія) є інтегрованим програмним середовищем для 

виконання чисельних розрахунків, комп'ютерного моделювання і 

обчислювальних експериментів, що охоплюють в тому або іншому обсязі 

різні області класичної і сучасної математики.  
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Для реалізації процесу нечіткого моделювання в середовищі 

MATLAB призначений спеціальний пакет розширення Fuzzy Logic Toolbox. 

У рамках цього пакету користувач може виконувати необхідні дії по 

розробці і використанню нечітких моделей. 

Застосуємо метод нечіткого моделювання для процесів сушіння та 

грануляції мінеральних добрив, які відбуваються в апараті «барабанний 

гранулятор  сушарка» (БГС). Для створення нечіткої моделі 

ознайомимося з технологічними особливостями об’єкта керування. 

 Упарена пульпа збирається у збірнику з мішалкою і обігрівом, звідки 

прямує в апарат БГС на грануляцію і сушіння.  

 Пульпа напилюється пневматичною форсункою на завісу сухого 

матеріалу (так званий ретур). Гранули укрупнюються, обкочуються і 

висушуються. Отримані гранули добре обкатані і містять 0,5-1% 

вологи. Сушіння здійснюється топковими газами, які подаються 

прямотечією до диспергованих часток при температурі на вході  

450 – 500 °С, температура газів на виході 90-100 °С.  

 Висушений продукт розділяють на три фракції: велику (  > 3,2 мм), 

товарну і дрібну ( <1 мм). Гранули великої фракції подрібнюються в 

лотковій дробарці, подрібнений матеріал іде знову на розсіювання 

разом з основним потоком матеріалу. Гранули +3,2 мм з верхнього сита 

подаються на валкову дробарку, а потім знову на розсівання.  

 Готовий продукт з нижнього сита йде на охолоджування, а потім на 

склад: фракції діаметром меншим за 1 мм повертаються в БГС як ретур.  

Задача полягає в тому, щоб розробити систему управління процесом 

гранулоутворення, яка б ґрунтувалася на нечіткому моделюванні, 

враховуючи досвід спеціалістів з керування БГС. 
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На перебіг процесів сушіння та гранулоутворення безпосередньо 

впливає щільність завіси ретуру перед форсункою, а також концентрація 

дрібної фракції на виході апарату БГС, вплив якої буде відчутно через 

певний час. Кваліфіковані експерти співставляють ці дві змінні для 

нанесення керувального впливу.  

Керувальною змінною у системі керування визначено тиск повітря у 

пневматичній форсунці.  

З огляду на це факторами моделі визначимо 2 нечіткі лінгвістичні 

змінні: «концентрація дрібної фракції на виході апарату» і «завіса», а як 

вихідну змінну — нечітку лінгвістичну змінну «тиск повітря  

пневмофорсунки» (далі «тиск»). 

За Терм - множину першої лінгвістичної змінної «концентрація 

дрібної фракції» візьмемо множину Т1={«Занадто мало», «Мало», 

«Нормально», «Багато», «Занадто багато»}, а за терм - множину другої 

лінгвістичної змінної «завіса» використаємо множину Т2={«рідка», 

«нормальна», «щільна»}. За терм - множину вихідної лінгвістичної змінної 

«тиск» візьмемо множину Т3={«Дуже малий», «Малий», «Зменшений», 

«Нормальний», «Збільшений», «Великий», «Дуже великий»}. При цьому 

терм першої вхідної змінної (концентрація дрібної фракції) 

оцінюватимемо по 20 - процентній шкалі, при якій цифрі 0 відповідає 

якнайменша концентрація дрібної фракції на виході БГС, а цифрі 20  

найбільша концентрація дрібної фракції на виході БГС. Терм другої 

вхідної змінної («завіса») оцінюватимемо за 10 - бальною шкалою, при 

якій цифрі 0 відповідає якнайменша густина завіси в БГС, а цифрі 10 — 

найбільша. Що стосується терма вихідної змінної «тиск», то її шкала буде 

проградуйована в МПа від 0,3 до 0,6 МПа в порядку зростання.  
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Порядок виконання роботи 

Процес розробки системи і моделі нечіткого висновку в 

інтерактивному режимі для розглянутого вище прикладу «Барабанний 

гранулятор – сушарка» полягає у виконанні наступної послідовності дій. 

1. Викликати редактор системи нечіткого висновку FIS, для чого 

у вікні команд набрати ім'я відповідної функції fuzzy. Після виконання цієї 

команди на екрані з'явиться графічний інтерфейс редактора FIS з ім'ям 

системи нечіткого висновку Untitled і типом системи нечіткого висновку 

(Мамдані), запропонованим за умовчанням.  

2. Оскільки в прикладі 1 розглянуто систему нечіткого висновку 

з двома входами, то необхідно додати в систему FIS, що розробляється, ще 

одну вхідну змінну. Для цього слід виконати команду меню Edit>Add 

Variable... >Input. У результаті виконання цієї команди на діаграмі системи 

нечіткого висновку з'явиться новий жовтий прямокутник з ім'ям другої 

вхідної змінної: input2. (див рис. 4.5) 

 

Рис. 4.5. Вид редактора FIS після додавання другої вхідної змінної 
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3. Змінимо імена вхідних і вихідних змінних, запропонованих 

системою MATLAB за умовчанням. Для цього необхідно виділити 

прямокутник з ім'ям відповідної змінної, виконавши клацання на його 

зображенні на діаграмі (сторони виділеного прямокутника мають червоний 

колір). Після цього слід набрати нове ім'я змінної в полі введення Name у 

правій частині редактора FIS. Результат надання нових імен змінним 

системи нечіткого висновку зображений на рис. 4.6. 

 

Рис.4.6. Вид редактора FIS після надання нових імен змінним 

Змінимо ім'я системи нечіткого висновку (Untitled), запропоноване за 

умовчанням. Для цього збережемо створену структуру FIS в зовнішньому 

файлі з ім'ям mytip.fis, виконавши команду меню File>Export>To Disk.... 

При цьому буде викликано стандартне діалогове вікно збереження файлу, 

в якому користувачу пропонують ввести ім'я відповідного файлу 

(розширення файлу приписується автоматично).  
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Залишимо без зміни запропоновані системою MATLAB за 

умовчанням: метод нечіткого логічного І (And method) — значення «min», 

метод нечіткого логічного АБО (Or method) — значення «max», метод 

імплікації (Implication)  значення «min», метод агрегації (Aggregation)  

значення «max» і метод дефаззификации (Defuzzification)  значення 

«сеntroid». Очевидно, що ці значення можуть бути змінені користувачем. 

4. Тепер необхідно визначити терми і їх функції належності для 

вхідних і вихідних змінних нашої системи нечіткого висновку. Для цієї 

мети слід скористатися редактором функцій належності, який може бути 

викликаний одним з наступних способів: 

 подвійним клацанням ЛКМ на значку прямокутника з ім'ям відповідної 

змінної;  

 командою меню Edit>Membership Functions... (заздалегідь повинен бути 

виділений прямокутник з ім'ям відповідної змінної). 

Після виклику редактора функцій належності кожної із змінних за 

умовчанням пропонується 3 терми з трикутними функції належності 

(рис.4.7).  

Спочатку змінимо діапазон значень вхідних змінних, для чого в 

полях введення Range і Display Range змінимо верхнє значення з 1 на 20 

(відсотків). Аналогічно виконуються зміни відповідних діапазонів для 

вхідної змінної «завіса» [0  10] і для вихідної змінної «тиск 

пневмофорсунки» [0.3  0.6]. Зміни підтверджуються натисканням на 

клавішу  Enter  на клавіатурі.  

Оскільки для вибраної задачі необхідно 5 термів, а система MATLAB 

пропонує за умовчанням тільки 3. Командою меню Edit>Remove All MFs  

видаляємо запропоновані терми. Командою меню Edit>Add MFs…  

створюємо 5 нових термів. (рис.4.8). 
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Рис.4.7. Вигляд редактора функцій належності після його виклику, з функціями 

належності для термів змінної «Концентрація дрібної фракції», запропонованих 

системою MATLAB за умовчанням 

 

 

Рис.4.8. Вигляд вікна створення необхідної кількості термів 

Далі змінимо назви термів першої вхідної змінної «Концентрація 

дрібної фракції», створених нами (mf1, mf2, mf3, mf4, mf5) на «Занадто 

мало», «Мало», «Нормально», «Багато», «Занадто багато»  

відповідно. Після чого змінимо тип крайніх функцій належності, 

запропонованих за умовчанням, на трапецієвидні функції (trapmf), 

вибравши відповідний пункт в полі Type.  
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Параметри функцій задамо таким чином: для терма  «Занадто 

мало» задамо параметри [0 0 2 6], для терма «Мало» – [2 6 10], для 

терма «Нормально» – [6 10 14], для терма «Багато» – [10 14 18], для 

терма «Занадто багато» – [14 18 20 20]. Вигляд редактора функцій 

належності після внесених змін зображений на рис.4.9. 

 

Рис.4.9. Вигляд редактора функцій належності після зміни назви термів і типу функцій 

належності для першої вхідної змінної «Концентрація дрібної фракції» 

Аналогічним чином змінимо назви термів другої вхідної змінної 

«Густина завіси». Після чого змінимо, запропонований за умовчанням, тип 

функцій належності на функції типу Гауса (gaussmf), вибравши 

відповідний пункт в полі Type. Параметри функцій належності залишимо 

без змін. За терм-множину другої лінгвістичної змінної «Завіса» 

використано «Рідка», «Нормальна», «Щільна». Вигляд редактора функцій 

належності після внесених змін зображений на рис.4.10. 
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Рис.4.10. Вигляд редактора функцій належності після зміни назви термів і типу їх 

функцій належності для другої вхідної змінної «Густина завіси» 

Нарешті, змінимо назви термів і параметри функцій належності 

для вихідної змінної «Тиск пневмофорсунки» . Нам необхідні 7 термів, а 

система MATLAB пропонує за умовчанням тільки 3. Командою меню 

Edit>Remove All MFs  видаляємо запропоновані терми. Командою 

меню Edit>Add MFs.  створюємо 7 нових термів. Далі змінимо назви 

термів вихідної змінної «Тиск пневмофорсунки», створених нами (mf1, 

mf2, mf3, mf4, mf5, mf6, mf7) на  «Дуже малий», «Малий», «Зменшений», 

«Нормальний», «Збільшений», «Великий», «Дуже великий»  відповідно. 

Після чого змінимо тип крайніх функцій належності, запропонованих за 

умовчанням, на трапецієвидні функції (trapmf), вибравши відповідний 

пункт в полі Type. Параметри функцій задамо таким чином: для терма 

«Дуже малий» задамо параметри [0.3 0.3 0.3283 0.3667], для терма 

«Малий» – [0.3283 0.3667 0.4083], для терма «Зменшений» –  [0.3667 

0.4083 0.45], для терма «Нормальний» –  [0.4083 0.45 0.4917],  
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для терма «Збільшений» –  [0.45 0.4917 0.5333], для терма «Великий» –  

[0.4917 0.5333 0.5716], для терма «Дуже великий» –  [0.5333 0.5716 0.6 

0.6]. Вид редактора функцій належності після внесених змін 

зображений на рис.4.11. 

 

Рис.4.11. Вигляд редактора функцій належності після зміни назви термів і типу функцій 

належності для другої вихідної змінної «Тиск пневмофорсунки» 

 

Порядок виконання роботи 

1. Створити модель процесу гранулоутворення мінеральних добрив 

у барабанному грануляторі - сушарці за методикою, описаною в роботі.  

2. Розробити математичну модель на базі нечіткого моделювання 

для власного технологічного об’єкта керування, узгодженого з викладачем. 

3. Дослідити типи функцій належності, які надає пакет, і способи їх 

математичного подання. 
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Вміст звіту 

Структурно – параметрична схема для власного об’єкта керування. 

Опис лінгвістичних змінних, які використані у моделі процесу, вікна 

редактора MATLAB із зображеннями та характеристиками функцій 

належності. 

Контрольні питання 

1. Як описати лінгвістичну змінну? 

2. Які існують види функцій належності? 

3. Як додати вхідну змінну в редакторі пакету FUZZY LOGIC? 

4. Як надати лінгвістичній змінній певне ім’я? 

5. Як задати терми і функції належності лінгвістичної змінної? 

6. Як змінити кількість термів? 

7. Як змінити тип функції належності? 

8. Як задати потрібний діапазон значень лінгвістичної змінної? 
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ЛАБОРАТОРНА РОБОТА №5 

СТВОРЕННЯ ТА ДОСЛІДЖЕННЯ СИСТЕМИ КЕРУВАННЯ 

ТЕХНОЛОГІЧНИМ ПРОЦЕСОМ НА БАЗІ НЕЧІТКОЇ ЛОГІКИ  

Мета роботи  навчитися створювати системи керування в умовах 

нечіткої інформації, реалізовувати і досліджувати їх засобами MATLAB. 

Короткі теоретичні відомості 

База правил систем нечіткого висновку призначена для формального 

представлення емпіричних знань або знань експертів у тій або іншій 

проблемній області. У системах нечіткого висновку використовують 

правила нечітких продукцій, в яких умови і висновки сформульовані в 

термінах нечітких лінгвістичних висловів. Сукупність таких правил далі 

називатимемо базами правил нечітких продукцій. 

База правил нечітких продукцій є кінцевою множиною правил 

нечітких продукцій, узгоджених відносно лінгвістичних змінних, що 

використовуються в них. Найчастіше базу правил подають у наступній 

формі структурованого тексту: 

ПРАВИЛО_1: ЯКЩО «Умова_1» ТО «Висновок_1» (F1)  

ПРАВИЛО_2: ЯКЩО «Умова_2» ТО «Висновок _2» (F2)          

... 

ПРАВИЛО_n: ЯКЩО «Умова_n» ТО «Висновок _n» (Fn) 

або в еквівалентній формі у MATLAB: 

RULE_1: IF Condition_1 THEN Conclusion_ 1  (F1)  

RULE_2: IF Condition_2 THEN Conclusion_ 2  (F2)  

... 

RULE_n: IF Condition_n THEN Conclusion_ n  (Fn)  
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Тут через Fi ( i{1, 2 ..., n} ) позначені коефіцієнти визначеності або 

вагові коефіцієнти відповідних правил. Ці коефіцієнти можуть приймати 

значення з інтервалу [0,1]. У випадку, якщо ці вагові коефіцієнти відсутні, 

зручно прийняти, що їх значення дорівнюють 1.  

У системах нечіткого висновку лінгвістичні змінні, які 

використовуються в нечітких висловах підумов правил нечітких 

продукцій, часто називають вхідними лінгвістичними змінними, а змінні, 

які використовуються в нечітких висловах підвисновків правил нечітких 

продукцій, часто називають вихідними лінгвістичними змінними. 

Таким чином, при формуванні бази правил необхідно визначити 

множину правил нечітких продукцій: P={R1, R2, ..., Rn},  множину вхідних 

лінгвістичних змінних: V={1 2 . n}, множину вихідних лінгвістичних 

змінних: W={1, 2, …, n}. Тим самим база правил нечітких продукцій 

вважається заданою, якщо задані множини P, V, W. 

Нагадаємо, що вхідна  i  V або вихідна  i  W лінгвістична змінна 

вважається заданою або визначеною, якщо для неї визначена базова терм-

множина з відповідними функціями належності кожного терма, а також дві 

процедури. Найпоширенішим випадком є використання як функції 

належності термів трикутних або трапецієвидних функцій належності, 

розглянутих вище. При цьому для зручності запису застосовують 

спеціальні скорочення для найменувань окремих термів вхідних і вихідних 

лінгвістичних змінних. 

Для формування бази правил в інтерактивному режимі в системі 

MatLab слід скористатися редактором правил, який може бути викликаний 

одним з наступних способів: 

 подвійним клацанням на значку квадрата в центрі з ім'ям 

створюваної системи нечіткого висновку (myfis); 
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 командою меню Edit > Rules. 

Оскільки спочатку база правил нечіткого висновку порожня, то після 

виклику редактора правил центральне багаторядкове поле введення не 

містить жодних правил. Для їх визначення слід використовувати поля 

меню і перемикачі в нижній частині графічного інтерфейсу редактора 

правил. Для задання першого правила слід задати у полі першої вхідної 

змінної (Концентрація дрібної фракції) терм «нормальна», для другої 

вхідної змінної (Завіса) теж терм «нормальна», для вихідної змінної (Тиск) 

 «нормальний». Далі слід перемикач Connection поставити в положення 

and (логічне І) і натискати на кнопку Add rule. Після цього перше правило 

з символами кирилиці відобразиться у верхньому рядку вікна.  

Таким же чином задають друге правило, для якого слід виділити 

імена термів відповідно «мала», «нормальна» і «збільшений», і третє 

правило з іменами термів «велика», «нормальна» і «збільшений» і так далі 

як показано на рис.5.1. Вигляд редактора правил після їх визначення для 

експертної системи, що розробляється, зображений на рис.5.2. 

Треба зауважити, що в полі введення Weight відображається вага 

кожного правила, яку можна змінювати в межах інтервалу [0, 1] (залишимо 

без зміни його значення за умовчанням, яке дорівнює 1 для всіх правил). 

Ця ж вага правил записується в круглих дужках у вікні правил після 

кожного з правил нечіткого висновку. 

Після завдання правил нечіткого висновку виявляється можливим 

отримати результат нечіткого висновку (значення вихідної змінної) для 

конкретних значень вхідних змінних. З цією метою необхідно відкрити 

програму перегляду правил командою меню View > Rules. 
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Рис.5.1. Вигляд редактора правил нечіткого висновку після їх визначення 

 

Після виклику програми перегляду правил для нашої системи 

нечіткого висновку за умовчанням для вхідних змінних запропоновані 

середні значення з інтервалу їх допустимих значень (значення [10 5] в полі 

введення Input). Це означає, що концентрація дрібної фракції оцінюється 

експертом як нормальна і густина завіси теж нормальна. Цим значенням 

вхідних змінних відповідає значення тиску пневмофорсунки в 0,45 МПа, 

яке відображається вище за прямокутники правил в правій частині вікна 

програми перегляду. 

Змінимо значення вхідних змінних для іншого випадку, якому 

відповідає концентрація фракції в 6 балів  (мало дрібній фракції) і густину 

завіси в 5 балів (нормальна).  
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Для цього курсор миші перемістимо в полі введення Input і введемо 

відповідні значення вхідних змінних: [6 5]. Система MATLAB виведе 

значення тиску пневмофорсунки 0,492 МПа. 

Оскільки процес нечіткого моделювання припускає аналіз 

результатів нечіткого висновку при різних значеннях вхідних змінних з 

метою встановлення адекватності розробленої нечіткої моделі, розглянемо 

й інші випадки. Припустимо, що концентрація дрібної фракції оцінюється 

в 14 балів (багато дрібної фракції), а густина завіси — в 7 балів (густа, але 

не дуже). Уведемо відповідні значення змінних. Тепер розроблена система 

нечіткого висновку рекомендує значення тиску пневмофорсунки, що 

дорівнює 0,397 МПа. 

Якщо ж припустити, що дрібної фракції як і раніше багато (14 балів), 

а густина завіси стала нормальною і оцінюється в 5 балів, то величина 

тиску пневмофорсунки істотно зміниться і дорівнюватиме 0,408 МПа.  

Якщо експертам така система видасться неадекватною, то можна 

змінити існуючі правила або додати нові, а також змінити параметри 

функцій належності вхідних і вихідний змінних.  

Для остаточного аналізу розробленої нечіткої моделі може виявитися 

корисною програма перегляду поверхні нечіткого висновку, яка може бути 

викликана командою меню View > Surface редактора FIS. 

Графічний інтерфейс програми проглядання поверхні нечіткого 

висновку для розробленої нечіткої моделі зображений на рис.5.3. 
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Ця програма використовується для загального аналізу адекватності 

нечіткої моделі, дозволяючи оцінити вплив зміни значень вхідних нечітких 

змінних на значення однієї з вихідних нечітких змінних. У разі потреби 

можна отримати графік залежності вихідної змінної від однієї з вхідних 

змінних. Для цього необхідно вибрати потрібну змінну в списку, що 

розкривається, X (input), а в списку, що розкривається, Y (input) вибрати 

значення -none-.  

 

  

Рис.5.2. Вигляд програми перегляду правил нечіткого висновку для значень вхідних змінних 

[10 5] 
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Рис.5.3. Вигляд програми перегляду поверхні нечіткого висновку для 

розробленої нечіткої моделі 

 

На формування бази правил систем нечіткого висновку часто 

впливають деякі додаткові чинники, які визначаються специфікою 

вирішуваної задача або алгоритму нечіткого висновку, що 

використовується. В основному ж для формування бази правил систем 

нечіткого висновку необхідно заздалегідь визначити вхідні і вихідні 

лінгвістичні змінні об'єкту керування, а також їх зв'язки і ступені впливу 

вхідних змінних на вихідні.  
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Порядок виконання роботи 

1. Узгодити з викладачем технологічний об’єкт керування. 

2. Виділити основні вхідні і вихідні змінні. 

3. Сформувати відповідні лінгвістичні змінні. 

4. Розробити систему керування об'єктом. 

5. Розробити правила для нечіткої системи керування продукції. 

6.  Використати засоби MATLAB для створення нечіткої системи 

керування. 

7. Дослідити вплив на значення керувальної змінної функцій 

належності вхідних змінних. 

Вміст звіту 

Структурна схема об'єкту. Функції належності. База правил нечіткої 

продукції. Документи MATLAB. 

Контрольні питання 

1. Як задати правила нечіткого висновку у системі MATLAB? 

2. Як проглянути задані правила? 

3. Пояснити зображення поверхні нечіткого висновку для 

розробленої нечіткої моделі і бази правил. 
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